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Product Overview

The PROSTAT® PGA-710B Autoanalyzer is an electrostaƟ c data analysis periph-
eral device for use with PROSTAT’s PFK-100 Instrument Set, which incorporates a 
PFM-711A ElectrostaƟ c Field Meter, CPM-720 Charge Plate Monitor and PCS-
730 Charging Source. Using the Autoanalysis System ApplicaƟ ons SoŌ ware, the 
PGA-710B will record, plot over Ɵ me and automaƟ cally analyze body voltage 
generaƟ on, electrostaƟ c decay, voltage retenƟ on and other electrostaƟ c events.  
Its disƟ ncƟ ve Voltage GeneraƟ on analysis feature is designed to document and 
calculate projected levels of typical Human Body and other voltages generated 
in the manufacturing process. 

It will also document and assess electrostaƟ c decay funcƟ ons, variaƟ ons in volt-
age retenƟ on, and ambient temperature and relaƟ ve humidity during each test. 
Once tests and analysis are completed, this unique system will construct and 
generate detailed wriƩ en test reports.

I. ESD Control Elements
 
Examples of ESD Control products that can be evaluated using the PGA-710B Graphic Autoanalyzer in-
clude, but are not limited to:

  IonizaƟ on Device and System Off set Voltage & Decay Performance
Footwear and Flooring combinaƟ ons 
Worksurface Voltage Suppression
Rolling Carts
Record process equipment fi eld voltages

Chairs (Siƫ  ng and Standing FuncƟ ons) 
Packaging Materials & Systems
ProducƟ on Aids & Materials
Other tests & evaluaƟ on

II. PGA-710B Autoanalysis Set Contents

The Autoanalysis System consists of the following components:

A. PGA-710B Autoanalyzer

The Autoanalyzer is an electronic data logging device incorporaƟ ng analog signal to digital conver-
sion, compuƟ ng, memory, and temperature and relaƟ ve humidity sensing capabiliƟ es. The Auto-
analyzer receives input from a measurement instrument, such as a Prostat PFM-711A Field Meter. 
Its output is typically via USB to a computer using Windows XP or later operaƟ ng system.  The unit 
is powered by a rechargeable lithium-ion baƩ ery.

NOTE
Do not connect a device having an input voltage greater than ±2.0 volts to the Autoana-

lyzer. Voltages over ±2.0 V may damage the device and will void the warranty. For further 
informaƟ on regarding instrument connecƟ ons contact Prostat customer service.
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B. PGA-710B Autoanalysis System ApplicaƟ on SoŌ ware Flash Drive

The Autoanalysis System ApplicaƟ ons Flash Drive includes the necessary programs to communi-
cate with, and operate the Autoanalyzer, install analyƟ cal programs, drivers and addiƟ onal Mi-
crosoŌ  soŌ ware. Before opening or loading soŌ ware, please be sure to review the Autoanalysis 
System SoŌ ware license agreement.

C. DocumentaƟ on

DocumentaƟ on includes this OperaƟ ng Manual, a Quick Start Guide, a Product Key Number for 
access to the ApplicaƟ on SoŌ ware, a TesƟ ng Guide for Flooring and Ionizers, and a Help fi le link in 
the ApplicaƟ on SoŌ ware.

D. ConnecƟ ons & Accessories 

The following cables and accessories are provided:

1. USB cable for connecƟ on of the PGA-710B Autoanalyzer to a computer USB port. Computer is 
not provided. (Part Number: PGA-710USB)

2. Shielded analog cable connects the analog output of a Prostat PFM-711A Field Meter (fi eld 
meter not provided) and the signal input of the PGA-710B Autoanalyzer (Part Number: PGA-
710AnaCab). 

3. The shielded voltage measurement cable with ground is used for body voltage, body reten-
Ɵ on and other measurement. Connect the green shield lead to ground to reduce the eff ects of 
ambient electrical noise. (Part Number: PGA-710ChgGen lead)

4. Input ShorƟ ng Shunt used to “zero” the PGA-710B Autoanalyzer during normal operaƟ ons. 
(Part Number: PGA-710CC)

5. Body voltage Hand Wand and Cable accessories. (Part Number: PFA-861-H)

6. BaƩ ery Charger (Part Number: PGA-710 Charger)

E. Shielded Measurement Cable

The shielded measurement cable is intented for use with the Prostat CPM-720 charge plate moni-
tor for measuring body voltage generaƟ on, charge retenƟ on, remote equipment and other elec-
trostaƟ c voltage sources. The signal conductor insulaƟ on is Red and the shield insulaƟ on is Green. 
Connect the Red lead to the CPM and the object being measured. Connect the Green shield to 
ground to reduce the eff ects of ambient electrical noise and transmiƩ ed energy. Do not connect 
the shield to the ground plate of the CPM.
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Figure 1: SchemaƟ c of Test Setup

III. CauƟ ons & Warnings

A. There are no user serviceable parts in the unit. Do not open the PGA-710B Autoanalyzer, or dam-
age the warranty seal. Only authorized Prostat technicians can provide repair and mechanical 
updates. Opening the unit or damaging the seal will void the warranty.

B. To prevent low voltage shock or damage to the unit or operator, do not operate the device when 
wet, or in a wet environment. 

C. Do not exceed ± 2.0 volt signal input to the Autoanalyzer. Higher voltages may damage the unit 
and will void the warranty.

NOTE: Contact Prostat Customer Service for informaƟ on regarding feasibility of connecƟ ng other 
than Prostat instruments and devices to the Autoanalyzer.

D. The Autoanalyzer is a precision instrument. Consider it as fragile. It can be damaged by abuse.  As 
with other fi ne instruments do not drop or cause mechanical shock.

E. The Autoanalyzer’s analyƟ cal program funcƟ on is based on operator input and the data supplied. 
Thus, the representaƟ ve accuracy and value of system calculaƟ ons are based on operator input 
and acƟ ons. Prostat is not responsible for data analysis results or the decisions made based on 
PGA-710B Autoanalysis System data analysis.

IV. Instrument Setup & Computer ConnecƟ on

The PGA-710B Autoanalyzer connects to a Prostat PFM-711A ElectrostaƟ c Field Meter via its analog out-
put lead and to a computer using USB cable. The PGA-710B and accompanying soŌ ware converts the fi eld 
meter and computer into a digital chart recording system with automaƟ c analysis and reporƟ ng features. 
The USB connecƟ on provides opƟ mal data transfer between the PGA-710B and the computer. 

A. System CompaƟ bility

The PGA-710B is intended for use ONLY with computers using current versions of Windows XP, 
Vista 32-bit/64-bit, Win7 32-bit/64-bit and Win8 operaƟ ng systems. Note that systems other than 
Windows 2003 may be required to download a MicrosoŌ  upgrade (.NET plaƞ orm) for proper 
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operaƟ on. The Autoanalysis System ApplicaƟ ons disk includes the MicrosoŌ  .NET Framework 4.0 
plaƞ orm, which will be installed with operator approval. Periodically check for .NET soŌ ware up-
dates at the MicrosoŌ  web site.

Systems using Windows XP should be:

• Updated with current service pack 3 criƟ cal updates

• Download current .NET Framework 4.0 version

• Then check for, and download current updates to the .NET Framework before loading the  
Autoanalysis soŌ ware.

B. Prior to Use

Charge the PGA-710B’s baƩ ery for 8-14 hours using the supplied AC/DC converter. EsƟ mated 
operaƟ ng baƩ ery life is approximately 8–10 hours of operaƟ on without connecƟ on to USB port or 
supplied baƩ ery charger. The unit charges when connected to the computer via USB.

SoŌ ware InstallaƟ on

Autoanalysis soŌ ware requires .NET Framework 4.0 installed on your computer. It can be installed either 
thru Windows Update or from the installaƟ on Flash Drive. 

For your convenience, .NET Framework 4.0 will install automaƟ cally from the Flash Drive if it’s not already 
installed.

Figure 2: .NET Framework 4 installaƟ on

C. Device Drivers

This version of soŌ ware is delivered with device drivers for Windows 7 through Win10. The drivers 
will install automaƟ cally from the Flash Drive once you iniƟ ate the main installaƟ on. In the event 
it didn’t install properly, you can be found them on the Flash Drive in folder Drivers. Install the fi le 
named VCP_V1.3.1_Setup or VCP_V1.3.1_Setup_x64 located in the Drivers folder.  Once complet-
ed, you can connect the device to your computer. Windows will complete the installaƟ on of the 
drivers.
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D. Quick Start: SoŌ ware InstallaƟ on & Instrument ConnecƟ ons

To load the Autoanalysis ApplicaƟ on soŌ ware:

1. Insert the Flash Drive into the computer’s USB Port

2. Select Open folder from the dialog box and double-click fi lename “Install.cmd”.

3. Follow the on-screen instrucƟ ons.

4. If prompted to install the .NET Frame-
work 4.0 Package, click Yes

5. Connect PGA-710B to computer via USB 
cable. Refer to Figures 1 – 7.

6. Connect the PGA-710B to your PFM-
711A Field meter via analog signal cable

7. Slide PGA-710B’s baƩ ery cut off  switch 
to the ON posiƟ on. 

8. Press the System ON/Sleep panel 
membrane pad and release when LED’s 
energize.

9. Your computer should recognize NEW HARDWARE.  

10. AŌ er installaƟ on Prostat “Autoanalysis System” shortcut will be installed on the desk top.

NOTE: The fi rst Ɵ me the PGA-710B soŌ ware is opened, the operator has an opportunity to select 
desired language and temperature display in either Celsius or Fahrenheit. 

Both language and preferred temperature display can be changed at any Ɵ me using the tool bar 
View > Language and View > Temperature Scale

 

Figure 3: USB ConnecƟ on

Figure 4: Front Panel Figure 5: Analog Input & Reset
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V. Controls

A. Operator controls include:

1. Main Power BaƩ ery Bus IsolaƟ on Slide Switch 
(Figure 7): Isolates baƩ ery from unit electron-
ics during storage and between operaƟ ng 
sessions.

a. In OFF posiƟ on BaƩ ery Charging (LED 4) 
remains OFF when unit charges using AC/
DC converter.

b. Note that small green LED next to Charger 
ConnecƟ on will energize during charging. 
See circle in Figure 7.

c. In ON posiƟ on, unit is energized in “sleep” 
mode but is not operaƟ onal unƟ l System ON/Sleep (Pad 1) buƩ on is pressed.

2. PAD 1 System ON/Sleep: Places unit in Normal OperaƟ on or Sleep modes.

Figure 6: Front Panel

Pad 4: Erase
[In Remote Ops]

Pad 3: Save
[In Remote Ops]

Pad 2: Start/Stop
[In Remote Ops]

Pad 1: On/Sleep

LED 1: Low BaƩ .

LED 2: Unit ON
[Start/Stop]

LED 3: Computer
Connected [Save]

LED 4: BaƩ ery
Charging [Erase]

Figure 7: Main Power BaƩ ery Bus Slide 
Switch Isolates BaƩ ery during Storage
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a. Press ON: LED’s #2 - #4 fl ash, then GREEN LED #2 blinks slowly to indicate unit is ON and 
operaƟ ng. (Figure 8)

b. Press Sleep: Press and hold pad unƟ l LED’s #2 - #4 energize temporarily, then release pad to 
place unit in standby or “sleep” mode. LED’s are OFF.

3. PAD 2 Start/Stop Recording Records data when in Remote Mode, i.e., when not connected to a 
computer. Remote operaƟ ons allow recording and storage of individual test fi les for computer 
download at a later Ɵ me. 

4. PAD 3 Save File when in Remote Mode. Once a remote test cycle is completed, i.e., PAD 2 is 
pressed to stop recording, pressing PAD 3 saves the test data as an individual fi le in the unit’s 
memory.

5. PAD 4 Erase File(s) when in Remote Mode.

a. Press Once erases current test before it is saved in unit memory

b. Press and Hold unƟ l LED’s 2–4 fl ash rapidly in sequence Erases ALL FILES in memory

6. Reset Re-boots PGA-710B in the case of latch up. See Figure 5.

B. LED Indicators

LED indicators provide informaƟ on in computer connect and remote operaƟ onal modes.

1. LED 1 RED: Low BaƩ ery level. Charge baƩ ery via USB connecƟ on to computer or using AC/DC 
converter. (See BaƩ ery ConsumpƟ on in Techni-
cal Specifi caƟ ons on page 39)

a. Unit operates normally during either 
charging mode. During operaƟ on more 
current is used than provided by USB con-
necƟ on. Periodically recharge baƩ ery with 
the AC/DC charger.

b. Note that LED 1 does not operate, i.e., 
indicate low baƩ ery or energize, when Bat-
tery Bus IsolaƟ on Switch is OFF.

2. LED 2 GREEN: Electronics energized and oper-
aƟ ng. 

a. ON when PGA-710B is energized, i.e., 
BaƩ ery Bus IsolaƟ on Switch is ON and System ON/Sleep pad is pressed. It blinks slowly to 
indicate unit is energized and operaƟ ng.

b. When in remote operaƟ ons

  1) Energized when unit turned ON, blinks to indicate unit energized and operaƟ ng
  2) Energized when PAD 2 Start/Stop Recording is pressed

Figure 8: ON/OFF: Power up or place PGA-
710B into “sleep mode”. 
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c. During fi le management in remote operaƟ ons:

  1) Blinks slowly in tandem with LED’s #3 during fi le recording
  2) Blinks fast with LED’s #3 to indicate fi le needs to be SAVED or ERASED
  3) Blinks fast, alternately with LED’s #3 & #4 during erase of ALL FILES in memory

3. LED 3 ORANGE/YELLOW: 

a. ON and Blinking when PGA-710B is connected & communicaƟ ng with computer 

b. When in remote operaƟ ons, energized when PAD 2 Start/Stop is pressed

c. During fi le management in remote operaƟ ons:

  1) Blinks slowly in tandem with LED’s #2 during fi le recording
  2) Blinks fast with LED’s #2 to indicate fi le needs to be SAVED or ERASED
  3) Blinks fast, alternately with LED’s #2 & #4 during erase of ALL FILES in memory

4. LED 4 YELLOW: 

a. ON when PGA-710B is connected to computer, energized steady ON to indicate the baƩ ery 
is charging

b. LED 4 is ON when unit is ON and connected to the AC/DC charger

c. During fi le management in remote operaƟ ons:

  1) Blinks once when fi le is saved
  2) Blinks fast, alternately with LED’s #2 & #4 during erase of ALL FILES in memory

VI. PreparaƟ on for Recording OperaƟ ons

A. Follow these iniƟ al steps to explore the 
PGA-710B’s operaƟ onal capabiliƟ es. 

1. Connect the PGA-710B to the com-
puter via the USB cable

2. Connect the PGA-710B to the PFM-
711A Field Meter analog output

3. Energize computer and instruments 

4. On computer, click “Autoanalysis 
System”  shortcut to start soŌ ware

5. The Session Wizard automaƟ cally opens the Start Screen. Choose from:

a. Start a New Session
b. Load Saved Session fi le
c. Import from Device
d. Start a New Session Wizard, or
e. Close the Start Screen

Figure 9: Autoanalysis SoŌ ware Start Screen
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6. Select “Start a New Session Wizard” and Click OK as in Figure 9, will open Session Wizard Test 
Type screen (Figure 10). Select Test Type and provide the requested informaƟ on to be included 
in test reports. See The Session Wizard secƟ on below for further details.

7. To open a fresh chart, simply select “Start a New Session”.

8. Press New Document symbol on the tool bar to open addiƟ onal new fi les

B. The Session Wizard

The Session Wizard is used to enter test infor-
maƟ on, material idenƟ fi caƟ on, locaƟ on and 
notes. All informaƟ on entered in the Wizard will 
be included in the generated charts and test re-
ports. InformaƟ on is entered in any of the basic 
test scenarios: General Test, Voltage Genera-
Ɵ on Test, and Decay Test. The Wizard consists 
of an Opening Screen, Two General InformaƟ on 
Screens and Test Specialty screens for Voltage 
GeneraƟ on and Decay Tests.

C. Opening Screen

The Opening Screen (Figure 10) is used to des-
ignate the type of test to be conducted. In the 
illustraƟ on at right, decay tesƟ ng is the intent of 
the test.

D. General InformaƟ on Screens

Two screens provide fi elds for a variety of descripƟ ve and locaƟ on informaƟ on that is included on 
all charts and in detailed reports. The following two screens are included in all test type formats.

E. Specialty Screens: Decay Tests

Decay measurements are used primarily for ionizaƟ on tesƟ ng. Decay tests have a beginning volt-
age where Ɵ ming begins or is “Reset”, and an ending voltage where Ɵ ming stops, or is “Cutoff ”. 
The following screens and windows are used to enter Reset and Cutoff  test voltages.
1. Designate the voltages used to Start and Stop the decay Ɵ me period.

Figure 10: Use the fi rst Session Wizard Window to Des-
ignate the Type Test

Figure 11: Technician, Material and General InformaƟ on Screens
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a. The Reset Voltage starts the Ɵ ming calculaƟ on period. 

b. Cutoff  Voltage ends the Ɵ ming calculaƟ on period.

2. The Decay Window off ers two means to designate Reset and Cutoff  Voltages.

a. Standard Reset and Cutoff  Voltages are (See Figure 12):

1,000 Volts – 100 Volts
1,000 Volts –   50 Volts
1,000 Volts –   10 Volts

b. Check the Custom Box to enter any two voltages for evaluaƟ on. Figure 12.

F. Specialty Screens: Voltage GeneraƟ on Tests

Voltage generaƟ on measurements may 
take several forms. In many tests, the 
movement is repeƟ Ɵ ous, much like a walk-
ing measurement. The Wizard screen at 
the right (Figure 13) allows the operator to 
esƟ mate the number of cycles before the 
measurements begin. The number can be 
changed later as necessary.

However, it is the number of operator en-
tered cycles that drive the soŌ ware’s iniƟ al 
algorithm analysis. Thus, it is important to 
be able to defi ne the number of walking 
steps or test cycles so that automaƟ c analy-
sis proceeds eff ecƟ vely.

G. Customize Charts & Create Templates

Figure 12: Standard Reset and Cutoff  Voltages (leŌ ), or check the Custom Box (right) and Manually Enter 

Figure 13: Enter the Number of esƟ mated Voltage Gen-
eraƟ on Test Cycles
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A new fi le can be confi gured with various indicators, voltage lines, alignment arrows, etc. One 
could construct a “template” using various desirable features for future use. When a New fi le is 
opened, record & control funcƟ ons are acƟ vated. Use the following to add custom labels and refer-
ence lines.

1. Select Document on the menu bar and a drop   down menu appears

2. Highlight Voltage Custom Labels and Click. See  
 Figure 14.

3. The Voltage Label ProperƟ es window opens.   
 See Figure 15, below.

4. Click on “Add”; 0.00 appears in the “Label Val 
 ues” and the “Label ProperƟ es” windows.

5. In the “Behavior” secƟ on True indicates the   
 zero Label (0.00) and Line will appear in   
 the chart.

6. In “Colors” both Label and Line colors are   
 individually selected using the drop down ar  
 row. In Figure 15, the zero Label and Line will  
 be Red. To change colors press the down   
 arrow(s) to open the color selecƟ on drop   
 down menu(s). Choose from several colors   
 (Figure 16) for customizing lines and labels. 

7. “Value” allows diff erent lines to be inserted in 
a chart at various voltage levels. For example, we 

might add colored lines at +100 and -100 volts to easily see any voltage generated peak that 
“exceeds ±100 volts”.

8. Click the “Add” buƩ on and 0.00 appears in Label Value. To create a disƟ ncƟ ve Label and Line 
at +100 volts enter “100” in the Data “Value” secƟ on. Open the Color Drop down menu for 
“LabelColor” and “LineColor” and select Blue. 100 will appear in the “Label Values” window. 

9. Repeat for “-100”, i.e., enter “-100” in the Data “Value” secƟ on. Open the Color Drop down 

Figure 14: Customize Chart Using Voltage Labels and 
Lines

Figure 15: One can create various Chart Voltage Lines & 
Labels in several colors
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menu and select Blue. -100 will appear 
in the “Label Values” window. See Figure 
17. Click OK and your ploƫ  ng chart re-
sembles Figure 18, on the next page. 

Use the various scale adjustment arrows 
to center the 0.00 Line, adjust the chart 
voltage and Ɵ me sweep ranges to meet 
anƟ cipated test needs. Once prepared 
to your liking, and before recording data, 
save the chart as a template to reduce 
future setup Ɵ me. For example, save the 
fi le as “ChgGen Template1.tst”. When-
ever the fi le is recalled the chart seƫ  ngs 
are as you leŌ  them and the fi le is ready 
to record data and be saved with a new 
name.

NOTE
CreaƟ ng Test Templates are convenient and save a great deal of Ɵ me. However, 

once data is recorded and saved in a fi le it cannot be reused as a template.

Figure 16: Color Drop down Menu Used to Change Label 
& Line Colors

Figure 17: In the Data secƟ on enter Voltage Value 
where a Chart Line is desired
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H. Set 
PGA-

710B Time & Date 

In preparaƟ on to record and analyze data, confi rm PGA-
710B system date and Ɵ me are correct. 

1. Press Edit on the menu bar to open the drop down   
 menu.

2. Select Device Control and a Device Control window   
 (Figure 19) appears on the screen.

3. With the PGA-710B energized and connected to the  
 computer via USB cable, Click the “Device Time” Read  
 buƩ on. The Read window will display the computer’s  
 current date and Ɵ me seƫ  ngs.

4. Press the Set Device Time buƩ on to set the PGA-
710B’s Ɵ me clock to the computer.

5. Press Done to close the window.

I. Sampling Rate

The PGA-710B’s default Sampling Rate is 50 samples/second, which is suitable for most audiƟ ng 
and analysis applicaƟ ons. To confi rm or modify the rate proceed as follows:

1. Open the Edit drop down menu. 

2. Select Device Control and a Device Control window (Figure 20) appears on the screen.

3. With the PGA-710B energized and connected to the computer via its USB cable, Click the 

Figure 18: New Chart with Red Zero Line and Blue Labels and lines at ±100

Figure 19: Use Edit drop down Menu to Access 
Device Control Window for seƫ  ng Set PGA-710B 
Date & Time
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“Sampling Rate” Read buƩ on. The Read window 
will display the computer’s current sampling 
rate.

4. To change the sampling rate, click the drop 
down menu arrow as seen in Figure 21:

a. Highlight the desired rate, i.e., 50, 100 or 
200 samples per second

b. Press Set

c. Press Done in the Device Control window to 
complete the sampling rate change.

J. Temperature & RelaƟ ve Humidity Sensor Factory CalibraƟ on & 
Adjustments

To ensure the sensor is operaƟ ng based on factory design and ini-
Ɵ al calibraƟ on, all adjustments or bias must be “cleared” from the 
sensor. To “clear” the soŌ ware seƫ  ngs:

1. From the Edit drop down menu, select Device Control (See 
Figure 22)

2. Confi rm the Humidity (Rh%) Value window is set at 
0.0, and click Clear

3. Confi rm the Temperature (F) Value window is set at 
0.0, and click Clear

4. Click Done to close the window.

 Once sensors are reset, use a calibrated temperature and 
humidity instrument as a reference to set the appropri-
ate bias for the most accurate temperature and humidity 
mesasurements. Follow the instrucƟ ons below for srƫ  ng 
temperature and humidity bias. 

K. CreaƟ ng a Temperature or RelaƟ ve Humidity Bias

If an acceptable temperature and humidity instru-
ment is available, the PGA-710B’s sensor can be 
operaƟ onally adjusted to approximate the reference 
as follows (See Figure 23):

1. From the Edit drop down menu, select Device 
Control

2. Enter the reference humidity in the Value win-
dow and click the Set buƩ on

3. Enter the reference temperature in the Value 

Figure 20: Use Edit Menu to Access Device Con-
trol Window to Set Sampling Rate per Second

Figure 21: Select Sampling Rate 

Figure 22: Clearing Humidity and Temperature 
Bias adjustments

Figure 23: AdjusƟ ng Temperature and Humidity 
Bias



18 Rev. E  / October 4, 2018

PGA-710B Autoanalysis System

window and click the Set buƩ on

4. Click Done to reset the sensor and close the window

Once a new seƫ  ng is entered into the soŌ ware, temperature and humidity indicaƟ ons will be based on 
the exisƟ ng sensor performance plus the infl uence of the new net seƫ  ng bias. For example, if the exisƟ ng 
indicaƟ on is 70°F and the seƫ  ng input is 65°F, a -5° bias will be added to the sensor’s measurement, and it 
will subsequently indicate 65°F. A similar adjustment can be made for relaƟ ve humidity. 

L. Open Current (Real Time) Measurement Digital Display 

A leŌ  panel area includes real Ɵ me measurements of volatge, 
temperature and relaƟ ve humidity. To display an addiƟ onal 
real Ɵ me measurement window showing the values of volt-
age, temperature and relaƟ ve humidity during the recording 
process:

1. Press Edit on the menu bar and select Current Measures. 
See Figure 24 and 25.

2. Place the Current Measures window in a convenient loca-
Ɵ on.

Data Recording Controls

The data recording Controls are located at the upper leŌ  corner of 
the screen. See Figures 25 and 26, below. The symbols are similar to the controls of a tradiƟ onal tape 
recorder (for those who may remember tape recorders). From leŌ  to 
right, the controls are:

1. Preview: Green Triangle starts chart plot and indicates 
magnitude of data. Data is not recorded, it allows adjust-
ments before recording. 

2. Record: Pressing the Red Circle begins data entry to fi le. 
When recording, the circle becomes Red and the plot 
trace changes color.

3. Pause: The verƟ cal Parallel Bars allow stop and start of 
data entry during Playback and 
when recording in General Mea-
surement and Decay test modes.  
Pause does not funcƟ on when 
recording Voltage GeneraƟ on.

4. Stop: The Black Square stops either Preview or Recording funcƟ ons.  
 If used to Stop the Preview funcƟ on, when Preview is pressed again  
 it resets the recording point to start ongoing Preview or Recording.

5. Short Cut Keys (Figure 27): Several funcƟ on keys are assigned to 
 assist in chart control:

Figure 24: Access Current Measures 
through the Edit Menu 

Figure 25: Current Measures window 
displays Voltage, Temperature and 
Humidity 

Figure 26: Chart Controls 
are similar to those of a 
tape recorder
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a. F5 Preview: Starts chart display of voltage and measurement 
levels. NOTE: Data is not entered into the fi le during Preview

b. F6 Record: Begins data capture of all measurement levels
c. F7 Pause: Stops and Starts Chart recording and playback
d. F8 Stop: Ends Preview, Recording or Playback.
e. F11 Auto Balance: Will align Preview or Recorded data to center 

of chart. Can also be used to automaƟ cally align Voltage, Tem-
perature or Humidity.

f. F12 Auto Min Max: Will automaƟ cally align display data to ver-
Ɵ cally uƟ lize the enƟ re chart view using the maximum and minimum data values.

N. Auxiliary Chart Control Window

When the LeŌ  Panel Control is closed to maximize the chart display the Auxiliary Chart Control 
window may be opened and posiƟ oned anywhere for operaƟ onal convenience. 

1. Open this window by selecƟ ng Chart Control on the Edit drop down 
menu.  

2. Use the mouse to drag and posiƟ on the window in a convenient loca-
Ɵ on.

Display Temperature & Humidity Data

Temperature and RelaƟ ve humidity are sensed and measured by the PGA-710B. The sensor is mounted 
in the boƩ om shell opening of the case for exposure to ambient condiƟ ons. It measures temperature and 

humidity external to the PGA-710B. Assuming the PGA-710B is stored 
in the area overnight, it requires only a few minutes for the system to 
reach opƟ mum performance.

To display temperature and, or humidity, check the Show Temperature 
and Show Humidity boxes listed under Charts in the leŌ  panel (Figure 
28). The default temperature display is Celsius (°C). To display Fahren-
heit (°F) or both °C and °F:

1. Open Document drop down menu and select Appearance OpƟ ons.  
 The “Chart ProperƟ es” window is opened (Figure 29).

2. In the Appearance secƟ on click TempaxesVisibility drop down menu  
 arrow. Select desired temperature scale(s).

The Appearance OpƟ ons, Chart ProperƟ es window (Figure 29) estab-
lishes what is to be displayed, i.e., Celsius (°C), Fahrenheit (°F) or both.  
Checking, or un-checking the “Show” boxes (Figure 28, above) deter-
mines whether or not the selected items are displayed in the chart. 

See Temperature & RelaƟ ve Humidity Sensor Factory CalibraƟ on & Adjustments for specifi caƟ ons and set-
Ɵ ng Rh or temperature bias.

Figure 27: Short Cut Key 
Controls

Figure 28: Check Show Tempera-
ture and Humidity Boxes to display 
related



20 Rev. E  / October 4, 2018

PGA-710B Autoanalysis System

Basics of Analyzing Body Voltage GeneraƟ on

For detailed measurement suggesƟ ons, see “How to Measure” manual. Once a recorded data fi le is estab-
lished, use the following guidelines for analysis:

1. Trim unwanted data from beginning or ending traces by using the Edit menu and click on Trim-
ming…. A fl oaƟ ng Edit window will open (Figure 30, below).

2. Press Trim LeŌ  tab and place the cursor on the plot trace at the selected point. Repeat with 
Trim Right.

3. Take care in selecƟ ng trim points to clearly defi ne data to be evaluated by the soŌ ware.

OPERATIONAL HINT
The System’s algorithm looks for paƩ erns in Minimum and Maximum peak 

values. One needs to defi ne the beginning and end of a set of Minimum and 
Maximum peaks. Every Minimum Peak must have a Maximum Peak.

a. PosiƟ on the LeŌ  trim point to defi ne a starƟ ng point  
 for the analysis. It should represent an iniƟ al 
 Minimum or Maximum value. Referring to Figure 30,  
 the LeŌ  trim cursor is placed before a Minimum peak  
 as shown by the circle.

b. PosiƟ on the Right trim point to defi ne the ending   
 point of the analysis. It should represent a fi nal Mini 
 mum or Maximum value. Referring to Figure 30, the  
 Right trim cursor is placed just aŌ er a Maximum peak  
 as shown by the circle at the right of the fi gure.

IMPORTANT NOTE: Maximum Peaks are posiƟ oned verƟ -
cally “Highest” on the chart, while Minimum Peaks are 
posiƟ oned “Lowest” on the chart.

Figure 29: Chart ProperƟ es Window

Figure 30: Trim Data Trace to IdenƟ fy Range 
of Minimum & Maximum Peaks to be used for 
Analysis and reporƟ ng.
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4. Click the Voltage Gen tab and enter the number 
of step cycles or measure-ment peaks between 
the trim points on the chart and press Analyze. 
If a clear number of peaks are entered and the 
program confi rms through its algorithm, it will 
display a series of Min and Max peaks with verƟ -
cal lines for each step cycle as shown in Figure 
31.

5. If a number of step cycles cannot be confi rmed 
by the analysis program the message in Figure 
32 appears requesƟ ng a change in the number 
of step cycles: 

Click OK and enter another number. If you con-
Ɵ nue to have diffi  culty, modify the chart Trim 
points and start this process again.

6. Press the Adjust tab in the EdiƟ ng Control window as shown in Figure 33. This allows you to 
add or remove Min or Max peaks from the analysis. 

a. To include a minimum peak in the analysis click Add Min, place 
the cursor over the peak to be included and LeŌ  Click your 
mouse.

b. To include a maximum peak in the analysis cick Add Max, place 
the cursor over the peak to be included and LeŌ  Click your 
mouse.

c. To eliminate a peak from the analysis select Remove, place the cursor over the verƟ cal 
peak idenƟ fi caƟ on line and LeŌ  Click your mouse. If you have diffi  culty idenƟ fying the verƟ -
cal line, expand the chart Time Scale and retry the Remove funcƟ on.

7. Once peaks for each walking step are idenƟ fi ed Release the data (Figure 33) for analysis and 
report preparaƟ on. Once the data is released, 3 Sigma data (Figures 34 & 35) are calculated, 
displayed and a report can be generated.

Figure 31: RepresentaƟ ve number of Cycles 
entered in Voltage GeneraƟ on

Figure 32: Error in Peaks entered in Edit Window.  Click 
OK and enter new value

Figure 33: Click Adjust then Re-
lease to begin the Autoanalysis
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8. The 3-Sigma Analysis is calculated for the Maxi-
mum and Minimum data sets and displayed as 
follows (Figure 35):

a. The average and standard deviaƟ on are calcu-
lated.

b. Three Ɵ mes the standard deviaƟ on are added 
to the average to establish the Highest end of 
the range.

c. Three Ɵ mes the standard deviaƟ on are sub-
tracted from the average to establish the Low-
est end of the range.

d. The Average, High and Low ends of each range 
are idenƟ fi ed and ploƩ ed on the chart.

Figure 34: Releasing Data and Process the 3-Sigma Analysis for Minimum 
& Maximum peak sets

Figure 35: 3-Sigma Ranges are calculated and 
ploƩ ed for Minimum & Maximum Peak Sets 
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Chart InformaƟ on: Test InformaƟ on Status

As one proceeds through the recording, trim, edit and analysis phases, the lower porƟ on of the chart 
screen provides Test InformaƟ on and status. Status indicaƟ ons are as follows:
 
      Incomplete: Data is not recorded; chart is blank.

      Edited:  Data is recorded but fi le is not yet analyzed

      Analyzed:  Data is trimmed and number of peaks idenƟ fi ed

      Processed:  Data is adjusted and “Released” ±3 Sigma Calculated & IdenƟ fi ed

VII. GeneraƟ ng Printed Charts & Reports

To generate printed charts and reports open the Document drop down menu and select Report View 
(Figure 40), which processes recorded data and provides a new screen view. Or, press the Report toggle 
buƩ on on the tool bar.

Figure 36: Chart Status Incomplete: No Recorded Data

Figure 37: Chart Status: Data Recorded & Trimmed – Chart Not Analyzed

Figure 38: Chart Status: Data Trimmed and Peaks IdenƟ fi ed

Figure 39: Chart Status: Data Evaluated and 3 Sigma Ranges Calculated
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1. To view a printable 8.5x11.0 inch chart of body voltage generaƟ on (Figure 41), select Body 
Voltage GeneraƟ on. A full chart will be displayed.

Figure 40: Select Report View from the Document drop down Menu or Click Toggle Chart/Report View. 
Then choose the desired Report type.

Figure 41: SelecƟ ng “Body Voltage Test” or “Voltage Test” from the Report Menu Gener-
ates a full size landscape Chart of Test Data
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2. To view and print a report, select Body Voltage GeneraƟ on Analysis  
 (Abs) (Figure 41A) meaning “absolute” graphic probability, or Body  
 Voltage GeneraƟ on Analysis. A three page report shown in Figures  
 43 & 44 will be generated that includes the following informaƟ on.

a. A summary display of the generated chart.

b. All informaƟ on entered in 
the New Session start menus, 
including Technician, Material 
DescripƟ on, LocaƟ on, Area, 
etc.

c. A performance summary

d. 3-Sigma analysis of Standing and Walking voltages

e. Probability analysis of Standing and Walking volt-
ages

3. To create a fourth page of remarks, press Document 
and select Remarks on the drop down menu (Figure 
42). All remarks entered in the opened window will 
appear on the fourth page of the report.

Figure 42: Select Remarks from Document 
Menu to Add Reports Comments 

Figure 43: Report Pages 1 & 2. Front Page provides charted data with analysis points, general informaƟ on 
and data summary. Pages 2 provides 3-Sigma ranges for Standing or minimum voltages, and Walking or 
maximum voltages.
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Absolute (Abs) vs. Non-Absolute Reports
SelecƟ ng an Absolute (Abs) report simply means 
that the probability curves displayed on the third 
page of the report are draw without regard to posi-
Ɵ ve or negaƟ ve polarity data; the absolute data 
values are employed in the analysis. In this form all 
curves are draw from leŌ  to right as shown in Figure 
44, above.

SelecƟ ng non-absolute report format allows the 
probability curve analysis to employ negaƟ ve and 
posiƟ ve data. Consequently probability curves may 
be drawn either from LeŌ  to Right, or Right to LeŌ  as 
shown at the right in Figure 45.

Figure 44: Report Pages 3 & 4. Page 3 displays Probability Analysis based on normal distribuƟ on of Aver-
age and Standard DeviaƟ on informaƟ on for Standing (Minimum) and Walking (Maximum) Voltage Data. 
Page 4 is opƟ onal and designed for Report Remarks.

Figure 45: Report Probability based on actual Data 
Polarity, i.e., not absolute
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General Voltage GeneraƟ on Measurements

Voltage GeneraƟ on analysis can be conducted on a variety of 
objects and used to assessed operaƟ onal procedures. Recording 
data in the voltage generaƟ on mode is similar to recording and 
analyzing body voltage. The major diff erences are the procedures 
used to obtain voltage generaƟ on, and selecƟ ng generic Voltage 
Analysis mode. One is limited only by their imaginaƟ on in capital-
izing on this feature. IllustraƟ ons include the following:

1. Personnel voltages while using a chair

2. Voltages generated by a rolling cart, or chair

3. Worksurface suppression analysis measurements 

4. Voltages measured within equipment

VIII. Basics of Voltage Decay Analysis

Decay tesƟ ng is typically employed for evaluaƟ ng ionizing systems, packaging dissipaƟ on, and other tech-
nical control elements where decay Ɵ me is a useful measurement or analysis tool. A separate set of analy-
sis procedures and Session Wizard details may be used for voltage decay measurements. For detailed 
informaƟ on regarding Decay TesƟ ng, refer to the PGA-710B Autoanalysis How to Test Guideline.

Once a new fi le is opened, decay test data is recorded using the same chart controls described above for 
recording voltage generaƟ on. Short Cut Keys are also used for this funcƟ on: 

Open the EdiƟ ng Control Trim window and enter desired decay test parameters if not previously entered 
through Session Wizard. In this illustraƟ on the decay test cycle Ɵ me starts (resets) at ±1,000 volts and 
ends (cutoof) at ± 10 volts, as shown in Figure 47.

Once the Decay Parameters are set, click Analyze to begin the decay analysis process. This will insert verƟ -
cal start and stop Ɵ me lines in the chart area indicaƟ ng those test cycles that have the entered param-
eters, in this case ±1,000 to ±10 volts. If the cycle does not meet these parameters, no verƟ cal start stop 
Ɵ me lines will be entered. Click Adjust then Release to complete the analysis. The horizontal voltage lines 
at ±1,000 and ±10 volts will be inserted at this point in the process.

Figure 46: Use Voltage Analysis Formats 
for General Measurements

Figure 47: Use Edit Window to Set Decay Parameters
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To generate a wriƩ en decay analysis report either open the Document drop down menu and select Re-
port View or click on the Report View Toggle BuƩ on. Note that the Report View Toggle BuƩ on allows the 
view to shiŌ  between Strip Chart View and the Report View.

In Report View one may select a full size chart that is produced in a landscape mode, or a detailed report 
produced in the standard portrait mode.

The decay reports and charts may be generated in a standard format as shown in Figure 52, or in a unique 
“assembled” format to compare each decay test cycle.

Figure 48: Click Analyze to Process Decay Data

Figure 49: Use the Document Drop Down Menu or Report View Toggle BuƩ on to shiŌ  to Report View
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Assembled Decay Charts

In the “assembled” format, all decay cycles are compared to each 
other regardless of how long it required generaƟ ng the enƟ re test 
series. 

In eff ect, the test set is “taken apart” by each test cycle and reas-
sembled in sequence. The PosiƟ ve cycles are compared to the 
NegaƟ ve cycles as shown in Figure 53. For example, the total de-
cay Ɵ me of all PosiƟ ve cycles was slightly more than 4.8 seconds, 
while the total of all NegaƟ ve cycles is approximately 5.7 seconds.

Decay tesƟ ng may be adapted to assess a variety of dissipaƟ ve materials and objects, including charge 
movement across materials, chairs, perform personnel decay analysis, as well as assess ionizaƟ on sys-
tems.

Figure 50: Use Voltage Analysis Formats 
for General Measurements

Figure 51: Page 1 of Standard Decay Report  of Test Data
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IX. Recording Test Data Without Computer ConnecƟ on (Remote TesƟ ng)

The PGA-710B can be used as a freestanding data logger/recorder for later downloading data to a 
computer for analysis. Before conducƟ ng remote measurements be sure to match the Ɵ me stamp 
of the PGA-710B with the computer you will use for data analysis, and erase all data presently in the 
PGA-710B’s memory. Failure to follow these two procedures may result in “corrupt” data.  To record a 
remote test:

1. Connect PGA-710B Autoanalyzer to PFM-711A Field meter via the analog output cable and 
complete test setup. Ground & Zero the Field meter before conducƟ ng measurements

2. Energize both instruments

3. Press the PGA-710B’s PAD #2 Start/Stop Recording to start recording, then commence the test 
procedure. LED’s #2 (Green) & #3 (Yellow) will blink conƟ nuously while recording data.

4. AŌ er the test evoluƟ on is complete, press PAD #2 Start/Stop Recording to stop recording. 
LED’s #2 (Green) & #3 (Yellow) will blink rapidly indicaƟ ng recording is stopped and fi le is ready 
to be Saved or Erased. Note: Excess data at ends of the test can be “trimmed” aŌ er computer 
download.

5. Press PAD #3 Save File to retain the test fi le in the unit’s memory, LED’s #2 & #3 will stop blink-
ing LED #3 will fl ash once to indicate the fi le is saved. Green LED #2 will revert to slow blinking 
indicaƟ ng the unit is ON and ready for further operaƟ ons. Or,

6. Press PAD #4 Erase File(s) to discard the test data, i.e., do not save fi le to unit memory. 

Figure 52: A Full Size Landscape Chart in the “Assembled” Format
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Note: Pressing and holding PAD #4 unƟ l LED’s 2, 3 & 4 Blink rapidly and alternately will erase all 
fi les in memory.

7. The PGA-710B will idenƟ fy each saved test fi le in sequence by date and Ɵ me, which are dis-
played when fi les are selected for download to the computer. 

The PGA-710B’s date and Ɵ me is established when last connected to a computer and the unit Ɵ me reset 
as previously described. It would be prudent to make note of date, Ɵ me and test informaƟ on for later fi le 
idenƟ fi caƟ on and informaƟ on entry.

Download Test Data from Device

To transfer remotely captured tests to a computer use the fol-
lowing procedure:

1. Connect the PGA-710B Autoanalyzer to the com-
puter and energize both instruments.

2. Start the PGA-710B Autoanalysis soŌ ware and se-
lect Import 

3. From Device on the Start Screen as shown in Figure 
53.

4. Or, Open File drop down menu and select Import 
from PGA-710B. (See Figure 54.)

5. Steps 2 - 4 will open the Import window. Click the Read 
buƩ on to display all available fi les for download from 
PGA-710B by Date and Time recorded. The highlighted 
fi le will be previewed in the adjoining window as in Fig-
ure 55.

6. Highlight selected fi le(s) to be downloaded, then:

a. Check box(s) to confi rm selecƟ on (Figure 56)

b. Press OK buƩ on

c. Selected fi le(s) will be downloaded to the computer

Figure 53: Select Import from Device from 
the Start

Figure 54: Use the File Menu to Import 
Data 

Figure 55: Open Import Window and Click 
“Read” to Display Stored Files

Figure 56: Check the Box to Select Download 
Files
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7. Downloaded Files will be displayed and indicated by Offl  oad - # on their fi le tab ( See Figure 57)

a. Click name tab to select offl  oaded fi le to preview 

b. Analyze and Save fi le(s) using new fi le names

X. ExporƟ ng & ImporƟ ng Data to and from Excel®  Spreadsheets

Data generated by the PGA-710B system may be exported to an Excel spreadsheet. 

1. Open the File drop down menu and select Export. 

2. File selecƟ on window will open allowing you to name or select the data Target fi le.

3. Once the Excel fi le is selected click Save and a new Excel fi le will be created containing all data 
acquired by the PGA-710B system.

Data generated by other measurement systems may be imported into the Autoanalysis System OperaƟ ng 
soŌ ware by way of an Excel spreadsheet. Once imported, the data can be easily analyzed by the PGA-710B 
soŌ ware and reports generated as though originally generated within the system. To import data from 
and Excel sheet the Ɵ me detail should be in a single column and correlate to the respecƟ ve voltage data in 
another column as discussed below. 

Figure 57: Offl  oaded File from PGA-710B Autoanalyzer
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To import data from an Excel sheet proceed as follows:

1. Select Import from the File drop down menu

2. File selecƟ on window will open allowing you to name and select the data source fi le. Highlight 
the desired fi le and click Open

3. The source fi le and an Autoanalysis import window (Figure 58) will be opened and superim-
posed on the sheet. The Import From Excel Spreadsheet window allows designaƟ on of the 
data to be imported for analysis by the PGA-710B program.

4. Select the Test Type from the drop down “Type” window (Figure 59). Once imported, the PGA-
710B Session Wizard will respond to the type designaƟ on.

5. The Date down arrow opens a calendar to designate the test date which will be “stamped” into 
the Autoanalysis soŌ ware.

6. Using the T[F] and Rh[%] entry panels temperature and relaƟ ve humidity can be included with 
the imported data. 

7. To highlight and select data to be imported (Refer to Figure 60)

a. Highlight the fi rst Time reference cell and simultaneously press <Shift> <Ctrl> and <↓>. 
This will highlight all cells containing data in that column.

b. Click the Time Select Range buƩ on in the Import Window and the Ɵ me data range will be 
automaƟ cally entered.

c. Highlight the fi rst Value reference cell and simultaneously press <ShiŌ > <Ctrl> and <↓>. 
This will highlight all cells containing data in that column.

d. Click the Voltage [V] Select Range buƩ on in the Import Window and the voltage value data 
range will be automaƟ cally entered.

e. When both Time and Voltage data ranges have been properly entered, the Import buƩ on 
will be acƟ vated. Pressing this buƩ on will import the selected data and immediately ge-
neate a chart for analysis.

Figure 58: Autoanalysis Excel Spreadsheet 
Import Window

Figure 59: Test Type Window
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ExporƟ ng Reports

The Export Report funcƟ on allows a completed test report to be exported in other fi le formats, including 
Acrobat (*.pdf), MicrosoŌ  Excel (*.xls), MicrosoŌ  Word (*.doc) and Text Rich Format (*.rƞ ) fi les. 

1. One must be in the Report View with the designated report displayed before the Export Report 
funcƟ on may be used.

2. Select the Report View on the Document drop down menu, or click the Toggle Chart/Report 
View.

3. Select the export report’s fi le format

4. Provide a target locaƟ on (Folder and Drive) and new fi le name

5. Click Save to export the fi le to its target locaƟ on

XI. Modifying XML Confi g File Defaults

Various chart color aƩ ributes can be accessed through the XML confi guraƟ on fi le located in Program 
Files, applicaƟ on program folder. Advanced users can modify this fi le in order to change some opƟ ons. 
Below you will fi nd brief descripƟ ons of some of these opƟ ons.

Before modifying the confi guraƟ on fi le, close the PGA-710B Autoanalysis System soŌ ware. 

Figure 60: Import Data from Excel Spreadsheet
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1. Open the confi guraƟ on fi le (AutoAnalysis.exe.confi g)  
located in Program Files > Prostat CorporaƟ on > 
Prostat Autoanalysis System 

2. Locate the Global Seƫ  ng or color scheme you wish 
to modify, e.g,. BlackAndwhite, BlackBackground, 
etc.

3. Within the scheme locate the aƩ ribute you wish to 
change, e.g., Voltage, Humidity, Temperature, etc. 

4. IdenƟ fy the element, color or display you wish to 
modify. The variable is between “x”

5. Save the AutoAnalysis.exe.confi g fi le

Open the Autoanalysis System soŌ ware and confi rm 
the modifi caƟ on. The following are a few illustraƟ ons 

Global seƫ  ngs

ShowStartScreen (valid values are “True” and “False”) – determines whether start screen appears each 
Ɵ me you start the applicaƟ on. In order to switch this opƟ on 
off  you can

1. Modify this entry to False or…

2. Uncheck Show start screen at startup check box 
on the start screen (Figure 62) or…

3. In running applicaƟ on access View menu and un-
check Show Start Screen at Startup menu

ReportFolder – Determines subfolder where report defi ni-
Ɵ ons are stored. Unless you know what you are doing never 
change this seƫ  ng.

UsePrintAppearanceScheme (valid values are “True” and “False”) – enables you to use diff erent appear-
ance schemes for prinƟ ng. This opƟ on is set to ON (True) by default. Appearance opƟ ons are described 
in next secƟ on. If this opƟ on is set to False (OFF), your printout will appear as seen on the screen (WYSI-
WYG).

Color Scheme Modifi caƟ ons

Five basic color schemes are available for display and prinƟ ng. Current color schemes are:

 Black and White   Decay Color Printer
 Black Background   Voltage Color Printer
 General Color Printer
  
The diff erences between each scheme are related to line, grid and background colors and scale displays 
that may be useful for various measurements. Line and grid scale colors, temperature type and other de-
faults can be modifi ed within a color scheme. Some illustraƟ ons follow.

Figure 61: AutoAnalysis.exe.confg File

Figure 62: Start Screen OpƟ ons
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Colors: The changeable aƩ ribute is between quotaƟ on marks. Modify the color name between quotes, 
e.g., “Gold” to “Lime”, then perform File, Save. Open the PGA-710B soŌ ware and check to insure the de-
fault change was correct and eff ecƟ ve.

Temperature: The temperature scale default is °C and will be displayed on the right of the strip chart view 
when the Show Temperature box on the LeŌ  Panel is checked.  The default within any scheme may be 
modifi ed using the following procedure and scale designaƟ ons.

1. Open the confi guraƟ on fi le (AutoAnalysis.exe.confi g) 
See Figure 63

2. Locate the Global Seƫ  ng or color scheme you wish 
to modify, i.e. BlackAndwhite, BlackBackground, etc.

3. Locate TempAxesvisibility 

4. Change the value =”x” as follows:

a. Celsius °C      value = “1” 
b. Fahrenheit °F value = “2”
c. Both °C & °F  value = “3”

5. Save the AutoAnalysis.exe.confi g fi le

Open the AutoAnalysis System soŌ ware and confi rm confi gura-
Ɵ on changes and proper operaƟ on. If the fi le becomes dam-
aged or inoperable, perform Remove SoŌ ware, Autoanalysis System from your control panel, and reinstall 
the soŌ ware.

Appearance Schemes Seƫ  ngs

The Appearance scheme is a set of opƟ ons that determine the appearance of a chart. Moreover, diff erent 
schema can be used to display charts on your computer screen and you can use others for prinƟ ng unless 
you set “UsePrintAppearanceScheme” described earlier to False. The Prostat Autoanalysis ApplicaƟ ons 
SoŌ ware package is delivered with 5 predefi ned appearance schemes. They are all defi ned in the XML 
confi g fi le described earlier.

DefaultAppearanceScheme – (valid values are the numbers defi ned in Available appearance schemes 
secƟ on described later) – the appearance scheme that will be used to display your charts on computer 
screen.

PrintAppearanceScheme – currently not used

PrintAppearanceScheme.General (valid values are the numbers defi ned in Available appearance schemes 
secƟ on described later) – the appearance scheme used to generate charts on general reports.

PrintAppearanceScheme.Decay (valid values are the numbers defi ned in Available appearance schemes 
secƟ on described later) – the appearance scheme used to generate charts on decay reports.

PrintAppearanceScheme.VoltageGen (valid values are the numbers defi ned in Available appearance 
schemes secƟ on described later) – the appearance scheme used to generate charts on voltage generaƟ on 
reports.

Figure 63: Modify Temperature Axis Scale 
for each Scheme
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Available Appearance Schemes

Each entry in this secƟ on defi nes a name for an appearance scheme. The numbers next to Appearanc-
eScheme key must be separated by a dot (for example AppearanceScheme.02). You can defi ne as many 
as 100 diff erent appearance schemes (numbers from 00 to 99). The numbers must be consecuƟ ve. The 
entries defi ned here appear in Print OpƟ ons (Figure 64) and Appearance OpƟ ons dialog boxes in the ap-
plicaƟ on soŌ ware.

Scheme Seƫ  ngs

The names of the entries in scheme defi niƟ on are self-explanatory. The important thing is that each entry 
is preceded by scheme name. For example:
<add key=”BlackAndWhite.BackgroundColor” value=”White” />
defi nes background color (white in this case) in BlackAndWhite appearance scheme.

Figure 64: Print OpƟ ons Dialog Box. Open in 
Report View mode using File Drop Down Menu

Figure 65: Document Appearance, Chart ProperƟ es Win-
dow Allows SelecƟ on of Various Appearance Schemes
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XII. Warranty InformaƟ on

Prostat® Warranty

Prostat CorporaƟ on expressly warrants that for a period of one (1) year from the date of purchase, that 
Prostat instruments will be free from defects in material (parts) and workmanship (labor). If Prostat re-
ceives noƟ ce of such defect during the warranty period, Prostat will replace at its expense such parts that 
it determines to be defecƟ ve. Any defecƟ ve part must be returned to Prostat postage prepaid with proof 
of purchase date.

Warranty Exclusions – THE FOREGOING EXPRESS WARRANTY IS MADE IN LIEU OF ALL OTHER PRODUCT 
WARRANTIES, EXPRESS AND IMPLIED, INCLUDING MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE, WHICH ARE SPECIFICALLY DISCLAIMED.  The express warranty will not apply to defects or dam-
age due to accidents, neglect, misuse, alteraƟ ons, operator error, or failure to properly maintain, clean, 
or repair products. Limit of Liability – in no event will PROSTAT or any seller be responsible or liable for 
special, incidental, or consequenƟ al losses or damages, under any legal theory including but not limited to 
contract, negligence, or strict liability.

Fulfi llment by Prostat of its express warranty obligaƟ ons described above will be purchaser’s exclusive 
remedy and will be Prostat’s and seller’s limit of liability for any breach of warranty or otherwise.
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PGA-710B Autoanalysis System Specifi caƟ ons

Size:    5.0 in (12.7 cm) L x 2.8 in (7.1 cm) W x 1.35 in (3.4 cm) H

Weight:   6.5 ounces (185 grams)

Input:    <±2 Volts

Output:   USB

Output Accuracy:  100 V ±5 %  
    1000 V ±1%  
    10.00 kV ±1%  
    20.00 kV ±1%  
  
Sampling Rate:  50, 100 and 200 Samples per second

File Size Limit:   ≈1 to 15 minutes per fi le, conƟ nuous recording at 50 samples/sec
    ≈7 minutes at 100 samples/sec
    3.5 minutes at 200 samples/sec

BaƩ ery ConsumpƟ on Notes: 

PGA-710B current fl ow with Main Power Switch ON:

1. During Sleep Mode (Main Power BaƩ ery Switch ON, unit OFF): 8 – 10mA. Unit in standby Panel 
keypad is energized. 

2. During Normal OperaƟ ons: 108mA 
Unit is operaƟ ng in remote or computer mode

3. Computer USB BaƩ ery Charge: 100mA 
OperaƟ ng in computer mode and receiving 100ma current from USB port reduces baƩ ery drain rate 
to 8ma. 

4. BaƩ ery Charge from AC/DC Charger: 280mA 
Charge baƩ ery with Main ON, OFF, or during operaƟ ons,

Temperature & RelaƟ ve Humidity Sensor:  

Temperature 
Range   -25 to + 85°C (-13°F to 185°F)
Accuracy  ± 0.4°C (≈1°F)
Response Time 6 ms in 20 I/min minimum air fl ow

Humidity
OperaƟ ng Range  0 – 100 percent (%) 
Accuracy  ±2.0% Rh, 0-100% non-condensing

PGA-710B Autoanalysis ApplicaƟ on SoŌ ware System Requirements

The following hardware and soŌ ware is required to run the Autoanalysis ApplicaƟ on SoŌ ware.
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• MicrosoŌ ® Windows® XP, Vista 32-bit/64-bit, Win7 32-bit/64-bit, Win8, Win10, Server 2003, Server 2008 
or Server 2012.

• 1 GHz Processor

• 512MB  RAM

• Disk Space

 32-bit: 850 MB
 64-bit: 2 GB

• 800 x 600 or higher-resoluƟ on display with 256 colors

• MicrosoŌ ® DirectX 9b

• Instrument input limits to ± 2 volts

Note: Providing over ±2 volts to the PGA-710B Autoanalyzer will void the warranty. For appropriate adapters or 
cables, please contact Prostat CorporaƟ on or your Prostat Authorized Reseller.
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